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I nt I'Od u CﬁOn (Ask a Question)

Libero® System-on-Chip (SoC) software provides a fully integrated Field Programmable Gate Array (FPGA)
design environment. However, a few users might want to use third-party synthesis and simulation tools outside
the Libero SoC environment. Libero is now integrated into the FPGA design environment. It is recommended to
use Libero SoC to manage the entire FPGA design flow.

This user guide describes the Custom Flow, a process to integrate Libero as a part of the larger FPGA design
flow.

Supported Device Families
The following table lists the device families that Libero SoC supports. However, some information in this guide
might only apply to a specific family of devices. In this case, such information is clearly identified.

Table 1. Device Families Supported by Libero® SoC

> SmartFusion 2 device addresses the fundamental requirements for advanced security, high reliability, and low power in

. ®
SmartFusion el : ™ > e ; v
critical industrial, military, aviation, communications, and medical applications.

IGLOO® 2 IGLOO 2 device is a low-power mixed-signal programmable solution.

RTG4™ RTG4 is Microchip's family of radiation-tolerant FPGAs.
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OVE rVieW (Ask a Question)

While Libero SoC provides a fully-integrated end-to-end design environment to develop SoC and

FPGA designs, it also provides the flexibility to run synthesis and simulation with third-party tools
outside the Libero SoC environment. However, some design steps must remain within the Libero
SoC environment.

The following table lists the major steps in the FPGA design flow and indicates the steps for which
Libero SoC must be used.

Table 1-1. FPGA Design Flow

Design Entry: HDL No Use third-party HDL editor/checker tool outside
. ® . .
Libero™ SoC if desired.

Design Entry: Configurators Yes Create first Libero project for IP catalog core
component generation.

Design Entry: System Builder Yes Stay in first Libero project

(SmartFusion® 2 and IGLOO® 2 devices

only)

Automatic PDC or SDC constraint No Derived constraints need all HDL files and a

generation derive_constraints utility when performed outside

of Libero SoC, as described in Appendix D—Derive
Constraints.

Simulation No Use third-party tool outside Libero SoC, if
desired. Requires download of pre-compiled
simulation libraries for target device, target
simulator, and target Libero version used for
backend implementation.

Synthesis No Use third-party tool outside Libero SoC if desired.
Design Implementation: Manage Yes Create second Libero project for the backend
Constraints, Compile Netlist, Place-and- implementation.

Route (see Figure 1-1)

Timing and Power Verification Yes Stay in second Libero project

Programming File Generation Yes Stay in second Libero project

Firmware Generation (SmartFusion 2 Yes Stay in second Libero project

only)

Firmware Debug (SmartFusion 2 only) No Use third-party tool outside Libero SoC if desired.

Important: You must download precompiled libraries listed under the Compiled

Simulation Libraries for SmartFusion® 2, IGLOO® 2, and RTG4™ section on the Libero
SoC Documentation page to use a third-party simulator.

In a CPLD or pure Fabric FPGA flow, enter your design using HDL or schematic entry and pass that
directly to the synthesis tools. The flow is still supported. However, SmartFusion® 2, IGLOO® 2, and
RTG4" FPGAs have significant proprietary hard IP blocks requiring the use of configuration cores

(SgCores) from the Libero SoC IP catalog. Special handling is required for the following blocks that
comprise SoC functionality.

« SmartFusion 2 and IGLOO 2
- SmartFusion 2 MSS (includes MDDR and eNVM)

- IGLOO 2 HPMS (includes MDDR and eNVM)
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- System Builder
- FDDR
- SerDes
- Oscillator
- CCC
- RAMs (TPSRAM, DPSRAM, URAM)
- TAMPER, and so on.
+ RTG4
- uPROM
- SerDes
- SerDes INIT
- FDDR
- FDDRINIT
- RCOSC macro
- CCC
- RAMs (TPSRAM, DPSRAM, URAM), and so on.
In addition to the preceding listed SgCores, there are many DirectCore soft IPs available for
various device families in the Libero SoC Catalog that use the FPGA fabric resources.

For design entry, if you use any one of the preceding components, you must use Libero SoC
for part of the design entry (Component Configuration), but you can continue the rest of your
Design Entry (HDL entry, and so on) outside of Libero. To manage the FPGA design flow outside
of Libero, follow the steps provided in the rest of this guide.

1.1. Component Life Cycle (saauestion)
The following steps describe the life cycle of an SoC component and provide instructions on handle

data:

1. Generate the component using its configurator in Libero SoC. This generates the following types
of data:
a. HDL files

b. Memory files
¢. Stimulus and Simulation files
d

Component metadata such as component file manifest text file, register configuration files
(* . reg) for MDDR/FDDR/SerDes and *cfg file for eNVM (SmartFusion 2 and IGLOO 2),
UPROM (RTG4)

e. Firmware drivers (*.h) files
f. Component SDC file

2. For HDL files, instantiate and integrate them in the rest of the HDL design using the external
design entry tool or process.

3. Supply memory files and stimulus files to your simulation tool.
Supply firmware drivers to your firmware project.

5. Supply Component SDC file to Derive Constraint tool for Constraint Generation. For more
information, see Appendix D—Derive Constraints for more details.

6. You must create a second Libero project, where you import the post-Synthesis netlist and your
component metadata (data files about the design components, such as register configuration
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files and initialization files), thus completing the connection between what you generated and
what you program.

1.2. Libero SoC Project Creation (as«aquestion)

Some design steps must be run inside the Libero SoC environment (Table 1-1). For these steps
to run, you must create two Libero SoC projects. The first project is used for design component
configuration and generation, and the second project is for the physical implementation of the
top-level design.

+ The enhanced constraint flow is used for both the first project and the second (implementation)
project because the enhanced constraint flow offers the constraint manager to better manage all
design constraints (SDC Timing, 10 PDC, Floorplanning PDC, and Synthesis NDC constraints). The
creation, import, and editing of constraints and their association with individual design tools are
controlled in one single management tool—the Constraint Manager.

+ The enhanced constraint flow generates automatic SDC and PDC constraints for common cores
such as the CCC, OSC, SerDes, and so on. For RTG4 designs using the RTG4FCCCECALIB core,
the automatic constraint generation (Derive Constraints) generates netlist constraint files (NDC).
In addition, SDC files are generated for association with synthesize or compile netlist design
flow steps. The SDC, PDC, or NDC constraints of these cores are set from the top of the design
hierarchy with the full hierarchical path given. You do not need to traverse from the top of the
design hierarchy to set a constraint on these IP cores, nor do you need to worry about the syntax
of the SDC, PDC, or NDC constraints such as hierarchy and pin separators, design object names,
and so on.

+ The automatically generated constraints, when applied, increase the chance of timing closure
with less effort and fewer design iterations.

1.3. Custom FIOW (Ask a Question)

The following figure shows how Libero SoC is integrated as a part of the larger FPGA design

flow with the third-party synthesis and simulation tools outside the Libero SoC environment. The
following figure shows various steps involved in the flow, starting from design creation and stitching
all the way to programming the device. The figure also shows the data exchange (inputs and
outputs) that must occur at each design flow step.
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Figure 1-1. Custom Flow Overview
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Tip:
= 1.p Component Data Files and Memory Config Files:
a. Component Data Files and Memory Config Files:
i. SmartFusion 2/IGLOO 2: *. reg files for MDDR/FDDR/SerDes blocks.
b. Memory Config Files:
i. SmartFusion 2/IGLOO 2: ENVM. cfq.
ii. RTG4:UPROM.cfg.
2. *.memn file generation for Simulation for different families:

a. SmartFusion 2: padmssenvmgen. exe takes ENVM.cfg as input and
generates ENVM init.mem.

b. IGLOO 2: pa4mssenvmgen.exe takes * . reg files for MDDRR/FDDR/
SerDes blocks and ENVM. c£g as input and generates ENVM init.mem.

€. RTG4:paidrtupromgen.exe takes UPROM. cfg as input and generates
UPROM. mem.

The following are the steps in the custom flow:
1. Component configuration and generation:
a. Create a first Libero project (to serve as a Reference Project).

b. Select the Core from the Catalog. Double-click the core to give it a component name and
configure the component.

Important: For SmartFusion 2 and IGLOO 2 System Builder and
SmartFusion 2 MSS blocks, generate the component in the SmartDesign
canvas after configuration of the SmartFusion 2 MSS block and System
Builder block.

This automatically exports component data and files. A Component Manifests is also
generated. See Component Manifests for details. For more details, see Component
Configuration.

2. Complete your RTL design outside of the Libero:
a. Instantiate the component HDL files.
b. The location of the HDL files is listed in the Component Manifests files.

3. Generate SDC/PDC/NDC constraints for the components. Use Derive Constraints utility to
generate the floorplanning . *pdc (only for SmartFusion 2/IGLOO 2), the timing . *sdc, and
netlist constraints . *ndc (in RTG4 designs using RTG4FCCCECALIB core) files based on:

a. Component HDL files

b. Component SDC/NDC files

c. User HDL files

For more details, see Appendix D—Derive Constraints.

4. Synthesis tool/simulation tool:

a. Get HDL files, stimulus files, and component data from the specific locations as noted in the
Component Manifests.

b. Synthesize and simulate the design with third-party tools outside the Libero SoC.
5. Firmware tool (SmartFusion 2 only):
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a. Getdrivers from the specific locations as noted in the manifest.

b. Edit source code to enable run time initialization for specific components, compile firmware
project.
Create your second (Implementation) Libero Project.

7. Remove synthesis from the design flow tool chain (Project > Project Settings > Design Flow >
clear the Enable Synthesis check box) if it is a netlist file.

8. Import the design source files (post-synthesis *.edn or *.vm netlist from synthesis tool):

- For SmartFusion 2 and IGLOO 2, import post-synthesis *.edn or *.vm netlist (File >
Import > Others).

- Component metadata such as *. reg files for MDDR/FDDR/SerDes (SmartFusion 2 and
IGLOO 2), *.cfg file for eNVM (SmartFusion 2 and IGLOO 2), and * . c£g file for yPROM
(RTG4).

9. Import any Libero SoC block component files. The block files must be in the *. cxz file format.
For more information on how to create a block, see SmartFusion2, IGLOO2, and RTG4 Block Flow
User's Guide.

10. Import the design constraints:
- Import I/0 constraint files (Constraints Manager > I/OAttributes > Import).

- Import floorplanning * . pdc files (Constraints Manager > Floor Planner > Import). If
your design contains CoreConfigP (SmartFusion 2 and IGLOO 2), import the PDC file
generated with the Derive Constraints utility (generate SDC and PDC constraints for the
components).

- Import *. sdc timing constraint files (Constraints Manager > Timing >Import). Import the
SDC file generated through Derive Constraint tool.

- Import *.ndc constraint files (Constraints Manager > NetlistAttributes > Import), if any.
In RTG4 designs using the RTG4FCCCECALIB core, import the NDC file generated through
Derive Constraints utility outside of Libero.

11. Constraint file and tool association

- In the Constraint Manager, associate the *.pdc files to place and route, the *. sdc files to
place and route and timing verifications, and the *.ndc files to compile netlist.

12. Complete design implementation
- Place and route, verify timing and power.
13. Validate the design

- Validate the design on FPGA and debug as necessary using the design tools provided with
the Libero SoC design suite.
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2. Component Configuration (saauestion)

The first step in the custom flow is to configure your components using a Libero reference project
(also called first Libero project in Table 1-1). In subsequent steps, you will use data from this
reference project.

If you are using any components listed earlier, under the Overview in your design, perform the steps
described in this section.

If you are not using any of the above components, then write your RTL outside of Libero and directly
import it into your Synthesis and Simulation tools. Then proceed to the post-synthesis section and
only import your post-synthesis *.edn or *.vm netlist into your final Libero implementation
project (also called second Libero project in Table 1-1).

2.1. Component Configuration Using Libero (asaauestion)

After selecting the components that must be used from the preceding list, perform the following
steps:

1. Create a new Libero project (Core Configuration and Generation):
a. Select the Device and Family that you target your final design to.

b. If you use the SmartFusion 2 MSS, SmartFusion 2, or IGLOO 2 System Builder, make the
appropriate selection in the Use Design Flow section of the New Project window.

2. If you use Smart Fusion 2 or IGLOO 2 System Builder (for IGLOO 2, you must use the System
Builder to configure the HPMS, eNVM, MDDR, and FDDR):

a. Use the System Builder to select your components and configure your system.

b. Generate your system in the System Builder and promote all its ports to the top level after
instantiating in a SmartDesign canvas (select all ports, right-click and choose promote to top).

O Tip: You need the port names to connect the rest of your design to the
= generated system.

c. Instantiate and configure any CCC or SerDes blocks in the same top-level SmartDesign or in
another SmartDesign component. Again, promote any ports to top.

d. Generate any SmartDesign instances.

e. Double-click the Simulate tool (Pre-Synthesis) to invoke the simulator. Exit the simulator
once it is invoked—this step generates the simulation files necessary for your project.

Q Tip: You must perform this step if you want to simulate your design
outside Libero.

f. Save your project—this is your reference project.
3. If you do not use the System Builder (SmartFusion 2 only):

a. Ifyou select the SmartFusion 2 MSS in the Use Design Flow subsection (step 1.b), the
SmartFusion 2 MSS Configurator automatically opens. Otherwise, in the Design Flow
window, double-click Configure MSS.

i. Double-click the SmartFusion 2 MSS instance to open its configurator.
ii. Configure the SmartFusion 2 MSS as per your requirements.
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O Tip: If you use the eNVM or the MDDR, you must use the SmartFusion 2
= MSS to configure it.

iii. Save and generate the SmartFusion 2 MSS component.

O Tip: If you do not use the System Builder, and you have the
= SmartFusion 2 MSS (using MDDR) or FDDR or SerDes blocks in your
design, you must follow the next steps.

b. Construct the Peripheral Initialization architecture in your final design. For more details,
about Peripheral Initialization, see:

+ SmartFusion2 DDR Controller and Serial High Speed Controller Initialization
Methodology

+ SmartFusion2 DDR Controller and Serial High Speed Controller Standalone Initialization
Methodology

c. Instantiate and configure any FDDR, CCC, or SerDes blocks in the top-level SmartDesign. It is
not necessary to connect them to anything else—just promote any ports to top.

d. Generate all the SmartDesigns built in the preceding steps.

Double-click the Simulate tool (Pre-Synthesis) to invoke the simulator. Exit the simulator
after it is invoked; this step simply generates the simulation files necessary for your project.

Q Tip: You must perform this step if you want to simulate your design
outside Libero.

For more information, see Simulating Your Design.

f. Save your project—this is your reference project.

4. If you use SmartFusion 2, and any of the SmartFusion 2 MSS peripherals (MDDR, FDDR, or
SerDes), you must export your firmware project (SoftConsole/IAR/Keil) from this Libero
project. For more information, see Building Your Firmware Project.

5. If you use RTG4:

a. If you wantto use the SerDes and the FDDR blocks in your design with built-in Initialization
logic, configure and generate the corresponding INIT cores (NPSS_SERDES_IF_INIT,
PCIE_SERDES_IF_INIT, and RTG4FDDRC_INIT) from the Libero catalog.

b. If you want to use the SerDes and the FDDR blocks in your design without built-in

Initialization logic, configure and generate the corresponding peripheral cores from the
Libero catalog.

O Tip: If you are using SerDes and FDDR blocks in your design, but not their

= corresponding INIT cores, you must construct the Peripheral Initialization
architecture in your final design to initialize the RTG4 SerDes and the FDDR
blocks. For further details regarding Peripheral Initialization, see:

* RTG4™ High Speed Serial Interface Configuration User Guide

+ RTG4 DDR Memory Controller with Initialization Configuration User
Guide
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https://coredocs.s3.amazonaws.com/Libero/SgCore/SERDES/rtg4_serdes_config_ug_2.pdf
https://coredocs.s3.amazonaws.com/Libero/SgCore/FDDR/rtg4_fddr_init_config_ug_2.pdf
https://coredocs.s3.amazonaws.com/Libero/SgCore/FDDR/rtg4_fddr_init_config_ug_2.pdf

2.2.

c. Instantiate and configure any FDDR, CCC, OSC, or SerDes blocks in the top level SmartDesign.

It is not necessary to connect them to anything else — just promote any ports to top.
d. If you wantto use RTG4 pPROM, add the yPROM block to the top level SmartDesign.
e. Generate all the SmartDesigns built in the above steps.

f. Double-click Simulate (Pre-Synthesis) to invoke the simulator. Exit the simulator after it is
invoked; this step only generates the simulation files that are necessary for your project.

Tip: To generate pnPROM. men file (used for simulating the yPROM contents)
= from the npPrROM. cfg file (generated by the configurator) using a stand-

alone executable outside Libero, see Simulating Your Design. You must

perform this step if you want to simulate your design outside of Libero.

g. Save your project—this is your reference project.

O Tip: You must follow the DRCs for components that you instantiate. For

= example, if you have multiple SerDes instances in your design, make sure
that each SerDes instance is configured to select a different physical SerDes
block. Refer to the user guides for the respective component DRCs for
details.

Component Manifests (aska question)

When you generate your components, a set of files is generated for each component. The
Component Manifest Report details the set of files generated and used in each subsequent step
(Synthesis, Simulation, Firmware Generation, and so on). This report gives you the locations of all
the generated files needed to proceed with the Custom Flow. To the component manifest in the
Reports area: Click Design > Reports to open the reports tab. In the reports tab, you see a set of
manifest.txt files (Figure 1-1), one for each component you generated.

O Tip: You must set a component or module as 'root' to see the component
= manifest file contents in the Reports tab.

Alternatively, access the individual manifest report files for each core component generated

or SmartDesign component from <project>/component/work/<component name>/<instance
name>/<component name> manifest.txt Or <project>/component/work/<SmartDesign
name>/<SmartDesign name> manifest.txt. A access the manifest file contents of each
component generated from the new Components tab in Libero, where the file locations are
mentioned with respect to the project directory.
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Figure 2-1. Accessing Component Manifest Report Files from Libero Reports Tab (For SmartFusion 2 System

Builder)
Reports @ X l -
=l Project Summary Al 0Ermors 0 Warnings 01nfo
gdprojlog E] Q A 0
|- toplevelsd reports - - - - — - "
B Microsemi Corporation - Microsemi Libero Software Release v2021.2 (Version 2021.2.0.5) =
omponents
|- toplevelsd
’ Date : Wed Jun 30 00:14:23 2021
toplevelsd_manifest.txt ° PoWe 3 P
I toplevelsd_sb Project D.\]fesl(inz\gbproj
toplevelsd_sb_SYS_BLDxml Component :  toplevelsd s
Family  : SmartFusion2

toplevelsd_sb_CCC_0_configur...
toplevelsd_sb_manifest.txt

+]- toplevelsd_sb_MSS ) ) ) )
HDL source files for all Synthesis and Simulation tools:

/Designs/gdproj/component /work/toplevelsd_sb/CCC_0/toplevelsd_sb_CCC_0_FCCC.v
/Designs/gdproj/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/coreahblite_addrdec.v
defaultslavesm.v

=]

/Designs/gdproj/component/Actel/DirectCore/CoreAHBLite/5.
/Designs/gdpro]/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/coreahblite_slavearbiter.v
/Designs/gdpro]/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/viog/core/coreahblite masterstage.v

2.100/rtl/vlog/core/coreahblite
2
2

/Designs/gdpro]/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1log/core/coreahblite_slavestage.v
2
2
1

/Designs/gdpro]/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1iog/core/coreahblite_matrixdxl6.v
/Designs/gdpro]/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/viog/core/coreahblite. v
/Designs/gdpro]/component/Actel/DirectCore/CoreConfigp/7.
/Designs/gdpro]/component/Actel/DirectCore/CoreResetP/7.1.100/rtl/vlog/core/coreresetp.v LI
/Designs/gdpro]/component/Actel/DirectCore/CoreResetP/7.1.100/rtl/vlog/core/coreresetp_pcie_hotreset.v
/Designs/gdproj/component/work/toplevelsd sb/FABDDR_0/toplevelsd_sb_FABDDR_O_FDDRC.v

/Designs/gdpro]/component /work/toplevelsd_sb/FABOSC_0/toplevelsd_sb_FABOSC_0_OSC.v

/Designs/gdproi/component /work/toplevelsd_sb/toplevelsd_sb.v

/Designs/gdpro]/component /work/toplevelsd_sb_MSS/toplevelsd_sb_MSS.v

.100/rtl/vlog/core/coreconfigp.v

UOUOUDUUUDBDUU UYL

HDL source files for Synopsys SynplifyPro Synthesis tool:
D:/Designs/gdpro]/component/work/toplevelsd_sb/FABDDR_0/toplevelsd_sb_FABDDR_O_FDDRC_syn.v
D:/Designs/gdproj/component/Actel/SgCore/0SC/2.0.101/0s¢c_comps.v
D:/Designs/gdproj/component /work/toplevelsd_sb_MSS/toplevelsd sb_MSS_syn.v

Focus on the following Component Manifest Reports:
+ If you use SmartFusion 2 or IGLOO 2 System Builder, read the file <system builder

name> sb manifest.txt.

+ Ifyou instantiated cores into a SmartDesign, read the file
<smartdesign name> manifest.txt.

+ If you created components for cores, read the <core component name> manifest.txt.

You must use all Component Manifests Reports that apply to your design. For example, if your
project has a SmartDesign with one or more core components instantiated in it and you intend
to use them all in your final design, then you must select files listed in the Component Manifests
Reports of all those components for use in your design flow.

2.3. Interpreting Manifest Files (asa question)

When you open a component manifest file, you see paths to files in your Libero project and pointers
on where in the design flow to use them. You might see the following types of files in a manifest file
based on the device family you are targeting:

+ HDL source files for all Synthesis and Simulation tools
« HDL source files for Synopsys SynplifyPro Synthesis tool
+ Stimulus files for all Simulation tools
+ Configuration files to be used for all Simulation tools
+ Firmware files for all Software IDE tools
+ Configuration files to be used for Programming
+ Configuration files to be used for Power Analysis
The following is the Component Manifest (example of a SmartFusion 2 System Builder component).
HDL source files for all Synthesis and Simulation tools:
D:/Designs/g4proj/component/work/toplevelsd sb/CCC_0/toplevelsd sb CCC 0 FCCC.v
D:/Designs/g4proj/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/
coreahblite addrdec.v
D:/Designs/gdpro’j/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/
coreahblite defaultslavesm.v

D:/Designs/g4proj/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/
coreahblite slavearbiter.v
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D:/Designs/g4proj/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/
coreahblite masterstage.v
D:/Designs/g4proj/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/
coreahblite slavestage.v
D:/Designs/g4proj/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/
coreahblite matrix4x16.v
D:/Designs/g4proj/component/Actel/DirectCore/CoreAHBLite/5.2.100/rtl/v1og/core/
coreahblite.v
D:/Designs/g4proj/component/Actel/DirectCore/CoreConfigP/7.1.100/rtl/v1og/core/
coreconfigp.v
D:/Designs/g4proj/component/Actel/DirectCore/CoreResetP/7.1.100/rtl/v1og/core/coreresetp.v
D:/Designs/g4proj/component/Actel/DirectCore/CoreResetP/7.1.100/rtl/v1og/core/
coreresetp pcie hotreset.v
D:/Designs/g4proj/component/work/toplevelsd sb/FABDDR 0/toplevelsd sb FABDDR 0 FDDRC.v
D:/Designs/g4proj/component/work/toplevelsd sb/FABOSC 0/toplevelsd sb FABOSC 0 OSC.v
D:/Designs/g4proj/component/work/toplevelsd sb/toplevelsd sb.v
D:/Designs/g4proj/component/work/toplevelsd sb MSS/toplevelsd sb MSS.v

HDL source files for Synopsys SynplifyPro Synthesis tool:
D:/Designs/g4proj/component/work/toplevelsd sb/FABDDR 0/toplevelsd sb FABDDR 0 FDDRC syn.v
D:/Designs/g4proj/component/Actel/SgCore/0SC/2.0.101/0osc_comps.v
D:/Designs/g4proj/component/work/toplevelsd sb MSS/toplevelsd sb MSS syn.v

Stimulus files for all Simulation tools:
D:/Designs/g4proj/component/work/toplevelsd sb/subsystem.bfm
D:/Designs/g4proj/component/work/toplevelsd sb MSS/CM3 compile bfm.tcl
D:/Designs/g4proj/component/work/toplevelsd sb MSS/user.bfm
D:/Designs/g4proj/component/work/toplevelsd sb MSS/test.bfm
D:/Designs/g4proj/component/Actel/SmartFusion 2MSS/
1.1.500/peripheral init.bfm

Firmware files for all Software IDE tools:
D:/Designs/g4proj/component/work/toplevelsd sb/FABDDR 0/sys config fddr define.h
D:/Designs/g4proj/component/work/toplevelsd sb MSS/sys config mss_clocks.h
D:/Designs/g4proj/component/work/toplevelsd sb MSS/sys config mddr define.h

Configuration files to be used for all Simulation tools:
D:/Designs/g4proj/component/work/toplevelsd sb/FABDDR 0/FDDR init.bfm
D:/Designs/g4proj/component/work/toplevelsd sb MSS/MDDR init.bfm

Configuration files to be used for Power Analysis:
D:/Designs/g4proj/component/work/toplevelsd sb MSS/MDDR init.reg
D:/Designs/g4proj/component/work/toplevelsd sb/FABDDR 0/FDDR init.reg

Each type of file is a necessary downstream in your design flow. The following sections describe
integration of the files from the manifest into your design flow.
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Constraint Generation (s question)

When performing configuration and generation, make sure to write/generate the SDC/PDC/NDC
constraint files for the design to pass them to Synthesis, Place-and-Route, and Verify Timing tools.

Use the Derive Constraints utility outside of the Libero environment to generate constraints instead
of writing manually. To use the Derive Constraint utility outside of the Libero environment, you
must:

*  Supply user HDL, component HDL and component SDC/NDC constraint files
+ Specify the top level module
+ Specify the location where to generate the derived constraint files

The SDC/NDC component constraints are available under <project>/component/work/

<component name>/<instance name>/ directory after component configuration and generation.

Important:

+ If using RTG4FCCCECALIB core for RTG4 designs, you must supply the
component NDC constraint file and specify the location to generate NDC
constraints for your design.

+ If using CoreConfigP and CoreResetP for SmartFusion 2 MSS, you must specify
the location to generate PDC constraints.

For more details on how to generate constraints for your design, see Appendix D—Derive
Constraints.
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4. Synthesizing Your Design (asa auestion)

One of the primary features of the Custom Flow is to allow you to use a third-party synthesis
tool outside Libero. The custom flow supports the use of Synopsys SynplifyPro. To synthesize your
project, use the following procedure:

1. Create a new project in your Synthesis tool, targeting the same device family, die, and package
as the Libero project you created.
a. Import your own RTL files as you normally do.

b. Set the Synthesis output to be Structural Verilog (. vm) or edif netlist (. edn).

2. Import Component HDL files into your Synthesis project:
a. For each Component Manifests Report:

i. Foreach file under HDL source files for all Synthesis and Simulation tools, import the
file into your Synthesis Project.

ii. Also, import all files under HDL source files for Synopsys SynplifyPro Synthesis tool.

3. Import the previously generated SDC file through the Derived Constraint tool (see Appendix
B—Sample SDC and PDC Constraints) into the Synthesis tool. This constraint file constrains the
synthesis tool to achieve timing closure with less effort and fewer design iterations.

Important: If you plan to use the same *. sdc file to constrain Place-and-
Route during the design implementation phase, you must import this * . sdc
into the synthesis project. This is to make sure that there are no design
object name mismatches in the synthesized netlist and the Place-and-Route
constraints during the implementation phase of the design process. If you do
not include this *. sdc file in the Synthesis step, the netlist generated from
Synthesis may fail the Place and Route step because of design object name
mismatches.

4. Import Netlist Attributes * . £dc, if any, into the Synthesis tool.
5. Run Synthesis.

The location of your Synthesis tool output has the *.edn or *.vm netlist file generated post
Synthesis. You must import the netlist into the Libero Implementation Project to continue with
the design process.

@ MICROCHIP


https://microchipsupport.force.com/s/newcase?pub_guid=GUID-7E5C0B1E-64A3-47B9-8651-373CCC35329A&pub_lang=en-US&pub_ver=15&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-918E5D92-7C92-4770-A4E6-C35DFEA66396&cover_title=SmartFusion%202%2C%20IGLOO%202%2C%20RTG4%20Custom%20Flow%20User%20Guide&tech_support_link=NA&revision_letter=N&source=PDF&title=Synthesizing%20Your%20Design&devices=

5. Simulating Your Design sa question)

To simulate your design outside of Libero (that is, using your own simulation environment and
simulator), perform the following steps:

1. Design Files
a. Pre-Synthesis simulation:
+ Import your RTL into your simulation project.

+ For each Component Manifests Report.

- Import each file under HDL source files for all Synthesis and Simulation tools
into your simulation project.

+ Compile these files as per your simulator's instructions.

b. Post-synthesis simulation:

+ Import your post-synthesis *.edn or *.vm netlist (generated in Synthesizing Your
Design) into your simulation project and compile it.

c. Post-layout simulation:

+ First, complete implementing your design (see Implementing Your Design). Make sure
that your final Libero project is in post-layout state.

+ Double-click Generate BackAnnotated Files in the Libero Design Flow window. It
generates two files:

<project directory>/designer/<root>/<root> ba.v/vhd <project directory>/designer/
<root>/<root> ba.sdf

+ Import both of these files into your simulation tool.

2. Stimulus and Configuration files:
a. For each Component Manifests Report:

+ Copy all files under the Configuration files to be used for all Simulation
tools and Stimulus Files for all Simulation Tools sections to the root
directory of your Simulation project.

b. Make sure that any Tcl files in the preceding lists (in step 2.a) are executed first, before the
start of simulation.

c. For SmartFusion 2 only:

* Review the subsystem.bfm file. Based on your usage of the MDDR, FDDR, or SerDes,
make sure that the following lines are present (or absent) in the subsystem.bfm file —
their presence indicates that the Component is used in your design. Absence indicates
that the Component is not used:

#define USE MDDR
#define USE FDDR
#define USE_SERDESIF 0
#define USE SERDESIF 1
#define USE SERDESIF 2
#define USE_SERDESIF 3

d. eNVM_init.mem: If you use the eNVM (SmartFusion 2 or IGLOO 2), or if you use IGLOO 2
and use MDDR, FDDR, or SerDes, you must use the padmssenvmgen.exe to generate the
ENVM_ init.men file, regardless of whether or not you use eNVM. The padmssenvmgen
executable takes all the peripheral *init. reg files and the ENVM. cfg file as inputs
through a Tcl script file and outputs the ENVM_init.memn file required for simulations. This
ENVM init.men file is required for component initialization in simulation. This file must
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be copied to the simulation folder prior to the simulation run. An example showing the
padmssenvmgen executable usage is provided in the following steps.

e. MPROM.mem: If you use RTG4 pPROM, you must use the padrtupromgen.exe to generate
the UPROM.mem file. The padrtupromgen executable takes the nPROM. c£g file as inputs
through a Tcl script file and outputs the uPROM. mem file required for simulations. This file
must be copied to the simulation folder prior to the simulation run.

3. Create a working folder and a sub-folder named simulation under the working folder.
The padmssenvmgen and padrtupromgen executable expect the presence of the simulation
sub folder in the working folder and the *. tcl script (steps 5 and 7) is placed in the simulation
sub folder.

4. For SmartFusion 2 and IGLOO 2 devices, copy all the component *init.reg files and the
ENVM. cfq file from the first Libero project (for component generation) into the working folder.
Examples of component *init.reg files are:

MDDR_init.reg
FDDR_init.reg
SERDESIF_Q_init.reg
SERDESIF_1_init.reg
SERDESIF_2_init.reg
SERDESIF_3_init.reg

For RTG4, copy the UPROM. c£g file from the first Libero project created for component
generation (or the UPROM. c£q file with any modified/updated contents) into the working folder.

SN T

5. IGLOO 2 device: Paste the following commands in a *. tcl script and place it in the simulation
folder created in step 3.

#Sample*.tcl for IGLOO 2 devices:

set_device -fam <family name>

—-die <internal die name>

-pkg <internal pkg name>
set mddr reg -path <path to MDDR register file/MDDR init.reg>
set fddr reg -path <path to FDDR register flle/FDDR init.reg>
set “serdesif0 _reg -path <path to SERDESIF 0 reglster file/SERDESIF 0 init.reg>
set serdesifl _reg -path <path to SERDESIF 1 _register file/SERDESIF 1 _init.reg>
set ~serdesif2 _reg -path <path to SERDESTIF 2 _register file/SERDESIF 2 _init.reg>
set serdesif3 _reg -path <path_ to SERDESIF 3 _register flle/SERDESIF 3 _init.reg>
setilnputicfg -path <path7toiENVM7conf1gurat1on7flle/ENVM cfg>
set _sim mem -path<path to ENVM Initialization File/ENVM init.mem>
gen_sim -use_init true

For the proper internal name to use for the die and package, see the *.pr7x file of the first
Libero project (used for component generation).

For an IGLOO 2 device, the argument use_init must be set to true for the gen sim command
if any of the *init.reg files are used.

Not all *init.reginthe example *.tcl may be needed. Include the reg file paths for only
those peripherals used in the design.

The set _sim mem command specifies the path to the output file ENVM_init.memthatis
generated upon execution of the script file with the padmssenvmgen executable.

6. Atthe command prompt or cygwin terminal, go to the working directory created in step 3.
Execute the padmssenvmgen command with the --script option and pass to it the * . tcl
script created in step 5.

For Windows":

<Libero SoC release installation>/designer/bin/padmssenvmgen.exe \
--script./simulation/<Tcl script name>.tcl
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For Linux :

<Libero SoC release installation>/bin/pad4mssenvmgen \
--script./simulation/<tcl_script name>.tcl

7. SmartFusion 2 device: Paste the following commands in a *. tcl script and place it in the
simulation folder created in step 3.

#Sample *.tcl for SmartFusion 2 devices
set device -fam <family>
-die <internal die name>
-pkg <internal pkg name>
set input cfg -path <path to ENVM.cfg>
set_sim mem -path <path to ENVM Initialization File/ENVM init.mem>
gen_sim -use_init false

For the proper internal name to use for the die and package, see the *.prjx file of the first
Libero project (used for component generation).

The argument use init must be set to false for SmartFusion 2.

For SmartFusion 2 device, the set mddr reg, set fddr reg, and set serdesif (x) reg
commands are not needed. All the peripheral register initialization information/data required to
run simulations is a part of the *_init.bfm files (listed in the Component Manifests reports of
each component), which must be copied from the first Libero SoC project (used for component
generation) to the top level directory of your simulation project (outside of Libero SoC).

Use the set sim mem command to specify the path to the output file ENVM init.memthatis
generated upon execution of the script file with the padmssenvmgen executable.

8. Atthe command prompt or cygwin terminal, go to the working directory created in step 1.
Execute the padmssenvmgen command with the --script option and pass to it the * . tc1l
script created in step 7.

For Windows:

<Libero SoC release installation>/designer/bin/pad4mssenvmgen.exe \
--script./simulation/<Tcl script name>.tcl

For Linux:

Libero SoC release installation>/bin/pad4mssenvmgen \
--script./simulation/<tcl_script_name>.tcl

9. RTG4: Paste the following commands in a *. tcl script and place it in the simulation folder
created in step 3.

#Sample *.tcl for RTG4 devices to generate URPOM.mem file from UPROM.cfg
set device -fam <family>
-die <internal die name>
-pkg <internal pkg name>
set input cfg -path <path to UPROM.cfg>
set _sim mem -path <path to UPROM Initialization File/UPROM.mem>
gen sim -use init false

For the proper internal name to use for the die and package, see the *.pr7x file of the first
Libero project (used for component generation).
For RTG4, there is a provision to simulate the UPROM by specifying the UPROM. c£g file using the
set input cfgcommand.
Use the set sim mem command to specify the path to the output file UPROM. mem that is
generated upon execution of the script file with the padrtupromgen executable.

10. At the command prompt or cygwin terminal, go to the working directory created in step 3.
Execute the padmssenvmgen command with the-script option and pass to it the * . tc1 script
created in step 9.
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For Windows:

<Libero SoC release installation>/designer/bin/pa4d4rtupromgen.exe \
--script./simulation/<Tcl script name>.tcl

For Linux:

<Libero SoC release installation>/bin/pa4d4rtupromgen \
--script./simulation/<tcl script name>.tcl

11. For SmartFusion 2 and IGLOO 2 devices, after successful execution of the pa4mssenvmgen
executable, check that the ENVM init.memn file is generated in the location specified in the
set sim mem command in the *.tcl script.

For RTG4, after successful execution of the padrtupromgen executable, check that the
pPROM.men file is generated in the location specified in the set sim mem command in the
*  tcl script.

12. For SmartFusion 2 and IGLOO 2 devices, copy the generated ENVM_init.mem file into the top
level simulation project to run simulation (outside of Libero SoC).
For RTG4, copy the generated npPrROM. mem file into the top level simulation folder of your
simulation project to run simulation (outside of Libero SoC).

Important: To simulate the functionality of SoC Components, download the pre-
compiled SmartFusion 2/IGLOO 2, RTG4 simulation libraries and import them into
your simulation environment as described here. For more details, see Appendix
C—Importing Simulation Libraries into Simulation Environment.
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6. Implementing Your Design (s« auestion)

After completing the Synthesis and Post-Synthesis simulation in your environment, you must use

Libero again to physically implement your design, run timing and power analysis, and generate your

programming file.

1. Create a new Libero project for the physical implementation and layout of the design. Make sure
to target the same device as in the reference project you created in Component Configuration.

2. After project creation, remove Synthesis from the tool chain in the Design Flow window (Project
> Project Settings > Design Flow > Uncheck Enable Synthesis).

3. Import your post-synthesis *.edn or *.vm file into this project, (File > Import > Synthesized
Verilog Netlist (VM)).

O Tip: Itis recommended that you create a link to this file, so that if you re-
= synthesize your design, Libero always uses the latest post-synthesis netlist.

a. Inthe Design Hierarchy window, note the name of the root module (shown in the following
figure).

Figure 6-1. Root Module in Design Hierarchy

Design Hierarchy B X
shon: 2
4 @ work

E=ﬁ mytop (top.edn)

. Desig... | Design Hier.. | Stimulus Hie... : Caiall:u__g_t Files |

4. Import the constraints into the Libero project. Use Constraint Manager to import * . pdc
/* .sdc/*.ndc constraints.
a. Import /0 * . pdc constraint files (Constraints Manager > 1/0 Attributes > Import).
b. Import Floorplanning *.pdc constraint files (Constraints Manager > Floorplanner >

Import. If your design contains CoreConfigP (SmartFusion 2 and IGLOO 2 only), make sure to
import the PDC file generated through Derive Constraint tool.

c. Import *. sdc timing constraint files (Constraints Manager > Timing > Import). If your
design has any of the cores listed in Overview, make sure to import the SDC file generated
through derive constraint tool.

d. Import *.ndc constraint files (Constraints Manager > Netlist Attributes > Import). If your
design is an RTG4 design using RTG4FCCCECALIB core, then make sure to import the NDC file
generated through derive constraint tool.

5. Associate Constraints Files to design tools

@ MICROCHIP
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a. Open Constraint Manager (Manage Constraints > Open Manage Constraints View).
Check the Place-and-Route and Timing Verifications check box next to the constraint file
to establish constraint file and tool association. Associate the * . pdc constraint to Place-and-
Route and the *. sdc to both Place-and-Route and Timing Verifications. Associate the
* . ndc file to Compile Netlist.

O Tip:

If Place and Route fails with this * . sdc constraint file, import this same
* _ sdc file to synthesis and re-run synthesis.

SmartFusion 2 and IGLOO 2 only: The derived floorplanning PDC file
constrains the CoreConfigP in an optimal location for placement and
improves timing performance of the design.

6. Click Compile Netlist, and then Place and Route to complete the layout step.
7. From all Component Manifests Reports:

- For SmartFusion 2 and IGLOO 2 devices, import all the files in the Configuration files to be
used for Programming and Configuration files to be used for Power Analysis sections
using the import component data Tcl command:

import component data -module "<name of root component>"?% \

-fddr "<path to FDDR.reg>" \

-mddr "<path to MDDR.reg>" \

-serdes0 "<path to SERDESIF 0 init.reg>"
-serdesl "<path to SERDESIF 1 init.reg>"
-serdes2 "<path to SERDESIF 2 init.reg>"
-serdes3 "<path to SERDESIF 3 init.reg>"
-envm_cfg "<path to eNVM cfg>"

P

- For RTG4, import all the files in the Configuration files to be used for Programming
and Configuration files to be used for Power Analysis sections using the
import component data Tcl command:

import component data \

-module "<name of root component>"@&\
-pprom _cfg "<path to pPROM cfg>"

Important:

a.

d.

@ MICROCHIP

"name of root component" refers to the name of the top hierarchical level
of the target Libero project where files are imported. For example, see
the Figure 1-1, "name of root component" is "name of root component of
Libero Implementation Project."

All configuration files are imported with the import component data.

Tcl commands are imported to the designer/<name of root
component>/component/ folder in the Libero project directory.

For SmartFusion 2 device, if you do not run SmartPower, skip importing the
* .reg files, andyou only need to import the ENVM. c£q file. For IGLOO

2 device, you must import all *. reg and eNVM. c£g files specified in all
your relevant Component Manifests Reports.

For RTG4, only UPROM .cfq file is imported.
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8. For SmartFusion 2/IGLOO 2 devices, if you need to change eNVM content, open the Update
eNVM Memory Content dialog box (see the following figure). Changes you make in this dialog
box are saved to the eNVM * . cfqg file you imported.

Figure 6-2. Update eNVM Memory Content
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PBL Programming Connectivity and Interface
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igs Device IO States During Programming

4 » Configure Security and Programming Options
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| |@‘ Update eMVIM Memory Content

4 b Program Design
@‘ Cenfigure Bitstream Help
@‘ Generate Bitstream
BB Run PROGRAM Action

4 b Debug Design
{1 Identify Debug Design
@ SmartDebug Design

4 » Handotf Design for Production
% Export Bitstream
# Export Programming Job
+L| BExport Pin Report
+'] Export BSDL
+| Export IBIS Model

4 » Handoff Design for Firmware Development

Configure Options...

m

¥ Configure Firmware Cores
B: Eport Firmware

1

Design Flow | Design Hierarchy | Stimulus Hierarchy | Catalog | Files |

9. For RTG4, if you need to change pPROM content, open the Update yPROM Memory Content
dialog box (see the following figure). Changes you make in this dialog box are saved to the
BPROM. cfq file you imported.
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Figure 6-3. uPROM Memory Content Dialog Box
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10. Generate a Programming File from this project and use it to program your FPGA.
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7. Building Your Firmware Project (s auestion)
This section describes how to build your firmware project when using the Custom Flow.

Important: This section applies to SmartFusion 2 devices only.

The following types of files make up a firmware project:

+ Source files (your firmware application)

+ Drivers: These are drivers provided to facilitate your use of SmartFusion 2 SoC Components and
Soft IP blocks. They include the CMSIS Hardware Abstraction Layer, which facilitates the use of
the Cortex -M3 processor, and peripheral drivers (for example, MSS SPI, MSS UART, and so on).

+ Peripheral Initialization Drivers: These files are generated by Libero SoC if you use the MDDR,
FDDR, or SerDes components. Libero translates configuration settings for these blocks into
register values that are stored in these files. You must import these into your firmware project
manually, as listed:

To build your firmware project, perform the following steps:

Important: Steps 1-4 are detailed in the SmartFusion 2 CMSIS Hardware
Abstraction Layer User Guide, which you can access using the Firmware catalog.

1. Select a Software IDE Tool.

2. Use the Firmware Catalog to download driver files for SoC Components or Soft IP you use in
your Libero project.

3. Create a new firmware project using your Software IDE tool of choice.
Import driver files and write your application code as you normally would.
5. Create a directory in your firmware project.

<my project>/drivers config/sys config

6. For each Component Manifests Report (generated in Component Configuration):

- Import each file in the Firmware files for all Software IDE tools section (Figure 2-1) into
your firmware project's drivers config/sys config directory.

7. Navigate to your Libero installation directory ( where Libero is installed), and then navigate to
the following directory:

<Libero install dir>\data\aPA4M\sysconfig

- There are two files here:
* sysconfig.c
* sysconfig.h.

- Import sysconfig.c (asis, do not modify the file) into your firmware project's
drivers config/sys config directory.

- Edit the local copy of sysconfig.h:
+ If you use the MDDR, change the following line:

#define SYS MDDR CONFIG BY CORTEX 0

@ MICROCHIP
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to

#define SYS MDDR CONFIG BY CORTEX 1

+ Similarly, depending on whether you use FDDR and SerDes blocks 0 to 3 in your design,
change their respective lines as preceding.

* Import sysconfig.h into your firmware project's drivers config/sys config
directory.

8. Import sysconfig.h into your firmware project's drivers config/sys_config directory.

/*====== * MDDR configuration */

#define MSS_SYS MDDR CONFIG_BY CORTEX 0 /

*====== * FDDR configuration */

#define MSS_SYS FDDR CONFIG BY CORTEX 0 /

*=======* SERDES Interface configuration 0 */

#define MSS SYS SERDES 0 CONFIG BY CORTEX

#if MSS_SYS SERDES 0 CONFIG BY CORTEX

#include "sys_config SERDESIF_0.h"

#endif

#define MSS_SYS SERDES 1 CONFIG BY CORTEX 0

#if MSS_SYS SERDES 1 CONFIG BY CORTEX #include "sys config SERDESIF 1.h"
#endif

#define MSS_SYS SERDES 2 CONFIG BY CORTEX 0

#if MSS_SYS SERDES 2 CONFIG BY CORTEX #include "sys config SERDESIF 2.h"
#endif

#define MSS_SYS SERDES 3 CONFIG BY CORTEX 0

#if MSS_SYS SERDES 3 CONFIG BY CORTEX

#include "sys config SERDESIF_3.h"

#endif
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8. Appendix A—Libero-Generated Hardware Configuration Files (s« auestion)

This appendix describes the hardware configuration files that Libero generates. These files are
intended to be imported into a firmware project. For more information, see Building Your Firmware
Project. Depending on the components present in a design, not all of these files are present.

sys_config.h

sys_config.c

sys_config_mss_clock
s.h

sys_config_mddr_defi
ne.h
sys_config_SERDESIF_

<0-3>.c

sys_config_SERDESIF_
<0-3>.h

@ MICROCHIP

This header file contains information about the SmartFusion 2 MSS hardware
configuration. The Libero hardware design flow generates it. The content of this file
is hardware design specific. This file must not be included in the application code.

This C source file contains information about the SmartFusion 2 MSS hardware
configuration. The Libero hardware design flow generates it. The content of this file
is hardware design specific. This file must be part of your software project if the
hardware design uses one of the DDR memory controllers or a SerDes interface.

This header file contains information about the SmartFusion 2 MSS hardware clock
configuration. The Libero hardware design flow generates it. The content of this file is
hardware design specific. This file must not be included in the application code.

This header file contains information about the SmartFusion 2 MSS DDR hardware
configuration. The Libero hardware design flow generates them if DDR is included in
the Libero design. The content of this file is hardware design specific. This file must not
be included in the application code.

These C source files contain information about the SmartFusion 2 SerDes interface
hardware configuration. The Libero hardware design flow generates them if SerDes
interfaces are included in the Libero design. A separate file is generated for each
SerDes interface. The content of these files is hardware design specific. These files
must be part of your software project if the hardware design uses one or more SerDes
interfaces.

These header files contain information about the SmartFusion 2 SerDes interface
hardware configuration. The Libero hardware design flow generates them if SerDes
interfaces are included in the Libero design. A separate file is generated for each
SerDes interface. The content of these files is hardware design specific. These files
must not be included in the application code.
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9. Appendix B—Sample SDC and PDC Constraints (s auestion)

For certain IP cores such as CCC, OSC, CoreResetP, and CoreConfigP, Libero SoC generates SDC
and PDC timing constraints. Passing the SDC and/or PDC constraints to design tools increases the
chance of meeting timing closure with less effort and fewer design iterations. The full hierarchical
path from the top-level instance is given for all design objects referenced in the constraints.

9.1. SDC Timing Constraints (askaauestion)

In the Libero IP core reference project, this top-level SDC constraint file is available from
the Constraint Manager (Design Flow > Open Manage Constraint View > Timing > Derive
Constraints).

Important: See this file to set the SDC constraints if your design contains CCC,
OSC, CoreResetP, and CoreConfigP components. Modify the full hierarchical path,
if necessary, to match your design hierarchy or use the Derive_Constraints utility
and steps in Appendix D—Derive Constraints on the component level SDC file.
Save the file to a different name and import the SDC file to the synthesis tool,
Place-and-Route Tool, and Timing Verifications, just like any other SDC constraint
files.

9.1.1. Derived SDC file (Ask a Question)

#Libero SoC uses “/” as the hierarchy separator and pin separators in the *.sdc file
create clock -name {<top level instance name>/FABOSC 0/I RCOSC 25 50MHZ/CLKOUT}\
-period 20 \

[get pins \{<top level instance name>/FABOSC 0/I RCOSC 25 50MHZ/CLKOUT} ]
create clock -name {<top level instance name>/mddr top sb MSS 0/CLK CONFIG APB} \
-period 40 \ [get pins {\

<top_level instance name>/mddr top sb MSS 0/MSS_ ADLIB INST/CLK CONFIG APB}]
create generated clock -name {<top level instance name>/CCC 0/GLO}\
-multiply by 4 -divide by 2 \

-source [get pins {<top level instance name>/CCC_0/CCC_INST/RCOSC_ 25 50MHZ}]\
-phase 0 \

[get pins {<top level instance name>/CCC_0/CCC_INST/GLO}]

set false path -ignore errors -through [get nets {\

<top_level instance name>/CORECONFIGP 0/INIT DONE\

<top level instance name>/CORECONFIGP 0/SDIF . " RELEASED} ]

set false path -ignore errors —through [get nets {\

<top_level instance name>/CORERESETP 0/ddr settled \

<top level instance name>/CORERESETP 0/count ddr _enable\

<top level instance name>/CORERESETP 0/release sdif* core\

<top level instance name>/CORERESETP 0/count sdif* enable}]

set false path -ignore_ errors -from [get cells {\

<top level instance name>/CORERESETP O/MSS HPMS READY int}] -to [get cells {
<top_level instance name>/CORERESETP 0/sm0_areset n rcosc\

<top level instance name>/CORERESETP 0/sm0 areset ~n_rcosc _gl}]

set false path -ignore errors -from [get cells {\

<top_level instance name>/CORERESETP 0/MSS_HPMS READY int)\

<top level instance name>/CORERESETP O/SDIF* PERST N re}] -to [get cells {\
<top level instance name>/CORERESETP 0/sdif* areset n _rcosc*}]

set false path —-ignore_errors —through [get nets {\

<top level instance name>/CORERESETP 0 CONFIG1 _DONE\

<top level instance name>/CORERESETP 0/CONFIG2 DONE\

<top_level instance name>/CORERESETP 0/SDIF* PERST N \

<top level instance name>/CORERESETP 0/SDIF* PSEL\

<top level instance name>/CORERESETP 0/SDIF* PWRITE\

<top__ level instance name>/CORERESETP 0/SDIF* _PRDATA[*]\

<top level instance name>/CORERESETP 0/SOFT EXT " RESET_OUT \

<top level instance name>/CORERESETP 0/SOFT RESET FZM\

<top_level instance name>/CORERESETP 0/SOFT M3 RESET \

<top__ level instance name>/CORERESETP 0/SOFT | MDDR DDR AXI S CORE_RESET \

<top level instance name>/CORERESETP 0/SOFT FDDR CORE RESET\

<top_level instance name>/CORERESETP 0/SOFT_ SDIF* PHY RESET \

<top level instance name>/CORERESETP 0/SOFT SDIF* CORE RESET \

<top level instance name>/CORERESETP 0/SOFT SDIF0 0 CORE RESET\
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<top_level instance name>/CORERESETP_0/SOFT_SDIFO_ 1 CORE_RESET}]

set max _delay 0 -through [get nets {\

<top_level instance name>/CORECONFIGP 0/FIC_2 APB M PSEL\

<top_ level instance name>/CORECONFIGP 0/FIC 2 APB M | PENABLE}] -to [get cells {\
<top_ level instance name>/CORECONFIGP 0/FIC_2 APB M PREADY*\
<top_level_lnstance_name>/CORECONFIGP_O/state[ 111

set min delay -24 -through \

[get nets {<top level instance name>/CORECONFIGP 0/FIC 2 APB M PWRITE\
<top_level instance name>/CORECONFIGP 0/FIC_2 APB M PADDR[*]\

<top_ level instance name>/CORECONFIGP 0/FIC 2 APB M [ PWDATA[*]\

<top level instance name>/CORECONFIGP O/FIC 2 APB M PSEL\

<top_level instance name>/CORECONFIGP 0/FIC_2 APB M PENABLE}]

9.2. PDC Physical Design Constraints (asa auestion)

In the Libero IP core reference project, this top-level PDC constraint file is available from
the Constraint Manager (Design Flow > Open Manage Constraint View > Timing > Derive
Constraints).

Important: See this file to set the PDC constraints for the CoreConfigP
component. Modify the full hierarchical path, if necessary, to match your design
hierarchy or use the Derive_Constraints utility and steps in Appendix D—Derive
Constraints on the component level PDC file. Save the * . pdc file to a different
name. Import the PDC file to your project and use it for Compile, just like any
other PDC constraint files.

9.2.1. Derived PDC file (Ask a Question)

This PDC design constraint file creates a region specifically for the CoreConfigP IP Core and places
the core in the region created. This constrains the Place and Route engine to place the core in

an optimal location resulting in better timing performance of the design when routed. The full
hierarchical path from the top is given for the constraint. Modify, if necessary, the hierarchical path
to match the names in your design.

# This file was generated based on the following PDC source files:
# W:/pc/11 7 1 14 1lily/Designer/data/aPA4M/cores/constraints/PA4M12000/

# coreconfigp.pdc
# define region -name {auto coreconfigp} -type inclusive 1104 159 1451 299 assign region

{auto_coreconfigp} {<top level instance name>/CORECONFIGP 0}

@ MICROCHIP
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10. Appendix C—Importing Simulation Libraries into Simulation
Environment (s question)

The default simulator for RTL simulation with Libero SoC is QuestaSim® Pro ME.

Pre-compiled libraries for the default simulator is available with Libero installation

at directory <install location>/Designer/lib/questasimpro/precompiled/vlog for
supported families.

Libero SoC also supports other third-party simulators editions of ModelSim, VCS, Xcelium, Active
HDL, and Riviera Pro. Download respective pre-compiled libraries from Libero SoC v12.0 and later
based on the simulator and its version.

Similar to the Libero environment, run. do file must be created to run simulation outside Libero.

Create a simple run.do file that has commands to establish library for compilation results, library
mapping, compilation, and simulation. Follow the steps to create a basic run.do file.

1. Create alogical library to store compilation results using the viib command, v1ib presynth.

2. Map the logical library name to pre-compiled library directory using the vmap command, vmap
<logical name> <pre-compiled directory path>.

3. Compile source files—use language-specific compiler commands to compile design files into
working directory.

- vlogfor .v/.sv
- vcomfor .vhd

4. Load the design for simulation using the vsim command by specifying name of any top-level
module.

5. Simulate the design using run command.

After loading the design, simulation time is set to zero, and enter the run command to begin
simulation.

In the simulator transcript window, execute run.do to run the simulation.

Sample run.do for SmartFusion2:
quietly set ACTELLIBNAME SmartFusion2
quietly set PROJECT DIR "W:/Test/basic test"

if {[file exists presynth/iinfo]} {
echo "INFO: Simulation library presynth already exists"
} else {
file delete -force presynth
vlib presynth
}
vmap presynth presynth
vmap SmartFusion2 "X:/Libero/Designer/lib/questasimpro/precompiled/vlog/SmartFusion2"

vlog -sv -work presynth "${PROJECT DIR}/hdl/top.v"
vlog "+incdir+${PROJECT DIR}/stimulus" -sv -work presynth "${PROJECT DIR}/stimulus/tb.v"

vsim -L PolarFire -L presynth -t 1lps presynth.tb
add wave /tb/*

run 1000ns

log /tb/*

exit

@ MICROCHIP


https://microchipsupport.force.com/s/newcase?pub_guid=GUID-7E5C0B1E-64A3-47B9-8651-373CCC35329A&pub_lang=en-US&pub_ver=15&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-94C9F264-83EE-4E32-B1A3-9B357FB463E7&cover_title=SmartFusion%202%2C%20IGLOO%202%2C%20RTG4%20Custom%20Flow%20User%20Guide&tech_support_link=NA&revision_letter=N&source=PDF&title=Appendix%20C%E2%80%94Importing%20Simulation%20Libraries%20into%20Simulation%20Environment&devices=
https://www.microchip.com/en-us/products/fpgas-and-plds/fpga-and-soc-design-tools/fpga/libero-software-later-versions#downloads

11. Appendix D—Derive Constraints s aueston)
This appendix describes the Derive Constraints Tcl commands.

11.1. Derive Constraints Tcl Commands (aska question)

The derive constraints utility helps you derive constraints from the RTL or the configurator
outside the Libero SoC design environment. To generate constraints for your design, you need the
User HDL, Component HDL, and Component Constraints files. The SDC/NDC component constraints
files are available under <project>/component/work/<component name>/<instance name>/
directory after component configuration and generation.

Each component constraint file consists of the set component tcl command (specifies the
component name) and the list of constraints generated after configuration. The constraints are
generated based on the configuration and are specific to each component.

11.1.1. Working with the derive_constraints Utility (aska question)

Derive constraints traverse through the design and allocate new constraints for each instance of
component based on previously provided component SDC/NDC/PDC files. For the CCC reference
clocks, it propagates back through the design to find the source of the reference clock. If the source
is an I/0, the reference clock constraint will be set on the I/0. If it is a CCC output or another clock
source (for example, SerDes, oscillator), it uses the clock from the other component and reports

a warning if the intervals do not match. Derive constraints will also allocate constraints for some
macros like on-chip oscillators if you have them in your RTL.

To execute the derive constraints utility, you must supply a . tcl file command-line argument
with the following information in the specified order.

The device information is specified in set_device.

The RTL path is specified in read_verilog or read_vhdl.

Set top level module as per the set_top_level.

Path to the component SDC/NDC files is specified in read_sdc or read_ndc.
Execute the files as per the derive_constraints.

ok W=

The SDC/PDC/NDC derived constraints file is specified in write_sdc or write_pdc or write_ndc.

The following is an example command-line argument to execute the derive constraints utility.

$ <libero installation path>/bin{64}/derive constraints derive.tcl

11.1.1.1. Set_dEVice (Ask a Question)

Description
Specify family name, die name, and speed grade.

set device -family <family name> -die <die name> -speed <speed>

Arguments
-family <family_name> String Specify the family name. Possible values are IGLOO® 2, SmartFusion®
2,and RTG4™.
-die <die_name> String Specify the die name.
-speed <speed> String Specify the device speed grade. Possible values are STD or -1.
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0 Command succeeded.

1 Command failed. There is an error. The console displays the error message.

List of Errors

ERR0023  Required parameter—die is missing
ERRO005  Unknown die MPF30

ERR0023  Parameter—die is missing value
ERR0023  Required parameter—family is missing
ERR0004  Unknown family

ERR0023  Parameter—family is missing value
ERR0023  Required parameter—speed is missing
ERRO007  Unknown speed <speed>

ERR0023  Parameter—speed is missing value

Supported Families

RTG4™
SmartFusion” 2
IGLOO" 2

Example

The die option is mandatory and must be specified.

The value of -die option is not correct. See the possible list of values in
option's description.

The die option is specified without value.
The family option is mandatory and must be specified.

The family option is not correct. See the possible list of values in
option's description.

The family option is specified without value.
The speed option is mandatory and must be specified.

The speed option is not correct. See the possible list of values in
option's description.

The speed option is specified without value.

set device -family SmartFusion 2 -die M2S090T -speed -1

11.1.1.2. read_verilog (aska question)

Description
Read a Verilog file using Verific.

read verilog [-1lib <libname>] [-mode <mode>] <filename>

Arguments

-lib <libname> String Specify the library that contains the modules to be added into the
library.

-mode <mode> String Specify the Verilog standard. Possible values
areverilog 95, verilog_ 2k, system verilog_ 2005,
system verilog 2009, system verilog, verilog ams,
verilog psl, system verilog mfcu. Values are case insensitive.
Defaultis verilog 2k.

filename String Verilog file name

0 Command succeeded

1 Command failed. There is an error. The console displays the error message.
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List of Errors

ERR0023  Parameter—Iib is missing value
ERR0023  Parameter—mode is missing value

ERRO015  Unknown mode <mode>

ERR0023  Required parameter file name is missing

ERRO016  Failed due to Verific's parser

ERROO12  set device is not called

Supported Families
RTG4™

SmartFusion” 2
IGLOO" 2

Example

The lib option is specified without value.
The mode option is specified without value.

The specified verilog mode is unknown. See the list of possible verilog
mode in—mode option description.

No verilog file path is provided.

Syntax error in verilog file. The console displays the Verific's parser
above the error message.

The device information is not specified. Use set device command to
describe the device.

read verilog -mode system verilog {component/work/top/top.v}

read verilog -mode system verilog mfcu design.v

11.1.1.3. read_VhC" (Ask a Question)

Description
Add a VHDL file into the list of VHDL files.

read vhdl [-1lib <libname>] [-mode <mode>]

Arguments

<filename>

-lib <libname> —

-mode <mode> —

filename —

Specify the library in which the content needs to be added.

Specifies the VHDL standard. Default is VHDL_93. Possible values
are vhdl_93, vhdl_87, vhdl_2k, vhdl_2008, vhdl_psl. Values are case
insensitive.

VHDL file name

0 Command succeeded

1 Command failed. There is an error. The console displays the error message.

List of Errors

ERR0023  Parameter—Ilib is missing value
ERR0023  Parameter—mode is missing value

ERR0O018  Unknown mode <mode>

ERR0023  Required parameter file name is missing

ERROO19  Unable to register invalid path.v file
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The lib option is specified without value.
The mode option is specified without value.

The specified VHDL mode is unknown. See the list of possible VHDL
mode in—mode option description.
No VHDL file path is provided.

The specified VHDL file does not exist or does not have read
permissions.
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read_vhdl (continued)

ERROO12  set device is not called The device information is not specified. Use set device command to
describe the device.

Supported Families

RTG4™
SmartFusion” 2
IGLOO" 2

Example

read_vhdl -mode vhdl 2008 osc2dfn.vhd
read vhdl {hdl/top.vhd}

11.1.1.4. Set_top_IEVEI (Ask a Question)

Description
Specify the name of the top-level module in RTL.

set top level [-1ib <libname>] <name>
Arguments
-lib <libname> String The library to search for the top-level module or entity (Optional).
name String The top-level module or entity name.

Command succeeded

0
1

Command failed. There is an error. The console displays the error message.

List of Errors

ERR0023  Required parameter top level is The top level option is mandatory and must be specified.
missing
ERR0023  Parameter—Ilib is missing value The lib option is specified without values.
ERRO014  Unable to find top level <top>in The specified top-level module is not defined in the provided library.
library <1ib> To fix this error, the top module or library name must be corrected.
ERRO017  Elaborate failed Error in the RTL elaboration process. The console displays the error
message.

Supported Families

RTG4™
SmartFusion’ 2
IGLOO 2

Example

set top level {top}

set top level -1lib hdl top
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11.1.1.5. read_SdC (Ask a Question)

Description
Read a SDC file into the component database.

read sdc -component <filename>

Arguments
-component — This is a mandatory flag for read sdc command when we derive
constraints.
filename String Path to the SDC file.
0 Command succeeded
1 Command failed. There is an error. The console displays the error message.

List of Errors

ERR0023  Required parameter file name is The mandatory option file name is not specified.
missing.

ERROO00  SDCfile <file path> is notreadable. The specified SDC file does not have read permissions.
ERR0O00T  Unable to open <file path> file. The SDC file does not exist. The path must be corrected.

ERRO008  Missing set component command in The specified component of SDC file does not specify the component.
<file path> file

ERRO009  List of errors from sdc file The SDC file contains incorrect sdc commands. Example when
there is an error in set_multicycle path constraint: Error while
executing command read sdc: in <sdc file path> file:
Eﬁorincon"nandset_multicycle_path: Unknown parameter
[get cells {reg all.

Supported Families

RTG4™
SmartFusion” 2
IGLOO" 2
Example
read sdc -component {./component/work/ccc0/cccO0 0/cccO _cccO0 0 PF CCC.sdc}

11.1.1.6. read_ndc (Ask a Question)

Description

Read a NDC file into the component database. The command is used for RTG4 designs using
RTG4FCCCECALIB core.

read ndc -component <filename>

Arguments
-component — This is a mandatory flag for read ndc command when we derive
constraints.
filename String Path to the NDC file.
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0 Command succeeded

1 Command failed. There is an error. The console displays the error message.

List of Errors

ERR0OOO1 Unable to open <file path> file The NDC file does not exist. The path must be corrected.
ERR0023 Required parameter—AtclParamO_is missing. The mandatory option filename is not specified.
ERR0023 Required parameter—component is missing Component option is mandatory and must be specified.
ERR0000 NDC file <file path> is notreadable. The specified NDC file does not have read permissions.

Supported Families
RTG4™

SmartFusion’ 2
IGLOO" 2

Example

read ndc -component {component/work/cccl/cccl_0/cccl_cccl 0 _RTG4FCCCECALIB.ndc}

11.1.1.7. derive_constraints (ask a question)

Description
Instantiate component SDC/PDC/NDC files into the design-level database.

derive constraints

Arguments
0 Command succeeded
1 Command failed. There is an error. The console displays the error message.

List of Errors

ERRO013  Top-level is not defined This means that the top-level module or entity is not specified. To fix this call, issue the
set_top_level command before the derive constraints command.

Supported Families

RTG4™
SmartFusion’ 2
IGLOO 2

Example

derive_constraints

11.1.1.8. Write_SdC (Ask a Question)

Description
Writes a constraint file in SDC format.

write sdc <filename>
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Arguments

<filename> String Path to the SDC file will be generated. This is a mandatory option.
If the file exists, it will be overwritten.

0 Command succeeded

1 Command failed. There is an error. The console displays the error message.

List of Errors

ERRO003  Unable to open <file path> file. File path is not correct. Check whether the parent directories exist.
ERRO002  SDCfile <file path> is notwritable. The specified SDC file does not have write permission.

ERR0023  Required parameter file name is missing. The SDC file path is a mandatory option and needs to be specified.

Supported Families

RTG4™
SmartFusion” 2
IGLOO" 2

Example

write sdc "derived.sdc"

11.1.1.9. Write_pdc (Ask a Question)

Description
Writes physical constraints (Derive Constraints only).

write pdc <filename>

Arguments
<filename> String Path to the PDC file will be generated. This is a mandatory option.

If the file path exists, it will be overwritten.

0 Command succeeded

1 Command failed. There is an error. The console displays the error message.

List of Errors

ERRO0O03  Unable to open <file path> file The file path is not correct. Check whether the parent directories exist.
ERRO002 PDC file <file path> is not writeable. The specified PDC file does not have write permission.

ERR0023  Required parameter file name is missing The PDC file path is a mandatory option and needs to be specified.

Supported Families

RTG4™
SmartFusion” 2
IGLOO" 2
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Example

write pdc "derived.pdc"

11.1.1.10. Write_ndc (Ask a Question)

Description
Writes NDC constraints into a file. The command is used for RTG4 designs using RTG4FCCCECALIB
core.

write ndc <filename>

Arguments
filename String Path to the NDC file will be generated. This is a mandatory option. If

the file exists, it will be overwritten.

0 Command succeeded
1 Command failed. There is an error. The console displays the error message.

List of Errors

ERR0O003  Unable to open <file path> file. File path is not correct. The parent directories do not exist.
ERRO002 NDCfile <file path> is not writable. The specified NDC file does not have write permission.

ERR0023  Required parameter AtclParamO_ is missing. The NDC file path is a mandatory option and needs to be
specified.
Supported Families

RTG4™
SmartFusion’ 2
IGLOO 2

Example

write ndc "derived.ndc"

11.1.1.11. add_inCIUde_path (Ask a Question)

Description
Specifies a path to search include files when reading RTL files.

add include path <directory>

Arguments
directory String Specifies a path to search include files when reading RTL files. This

option is mandatory.

0 Command succeeded
1 Command failed. There is an error. The console displays the error message.
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List of Errors

ERR0023 Required parameter include path is missing. The directory option is mandatory and must be provided.

Important: If the directory path is not correct then add_include_path will be
passed without an error. However, read verilog/read vhd commands will be
fail due to Verific's parser.

Supported Families

RTG4™
SmartFusion’ 2
IGLOO" 2

Example

add_include path component/work/COREABCO/COREABCO 0/rtl/vlog/core
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The revision history describes the changes that were implemented in the document. The changes
are listed by revision, starting with the most current publication.

N 05/2025 This document is released with Libero SoC Design Suite v2025.1 without
changes from v2024.2.

M 09/2024 + Updated Appendix C—Importing Simulation Libraries into Simulation
Environment.

L 08/2024 »  Updated Figure 1-1.

+ Updated step 4 in Synthesizing Your Design.

* Updated Appendix C—Importing Simulation Libraries into Simulation
Environment.

K 02/2024 This document is released with Libero SoC Design Suite v2024.1 without
any updates from v2023.2.

J 08/2023 This document is released with Libero SoC Design Suite v2023.2 without
any technical content updates from v2023.1.

H 05/2023 Updated step 7 in Implementing Your Design.

G 04/2023 + The information related to Polarfire family is moved to a separate

document. For details, see PolarFire Custom Flow User Guide.

+ Editorial updates are done throughout the document.

B 12/2022 Updated step 7 in Implementing Your Design.
E 08/2022 Added Error Codes for the following sections:
+ set_device
+ read_verilog
*  read_vhdl
+  set_top_level
*  read_sdc
* read_ndc
+ derive_constraints
+ write_sdc
* write_pdc
+ write_ndc
* add_include_path
D 04/2022 This document is released with Libero SoC Design Suite v2022.1 without

any technical content updates from v2021.3. Editorial updates have been
made throughout the document.

C 12/2021 + Added Constraint Generation.

+ Updated Appendix D—Derive Constraints.
B 08/2021 + Updated Custom Flow.

» Added Appendix D—Derive Constraints.

A 08/2021 Initial Revision.
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Microchip FPGA Support

Microchip FPGA products group backs its products with various support services, including
Customer Service, Customer Technical Support Center, a website, and worldwide sales offices.
Customers are suggested to visit Microchip online resources prior to contacting support as it is
very likely that their queries have been already answered.

Contact Technical Support Center through the website at www.microchip.com/support. Mention the
FPGA Device Part number, select appropriate case category, and upload design files while creating a
technical support case.

Contact Customer Service for non-technical product support, such as product pricing, product
upgrades, update information, order status, and authorization.

*  From North America, call 800.262.1060
*  From the rest of the world, call 650.318.4460
+ Fax, from anywhere in the world, 650.318.8044

Microchip Information

Trademarks

The “Microchip” name and logo, the “M” logo, and other names, logos, and brands are registered
and unregistered trademarks of Microchip Technology Incorporated or its affiliates and/or
subsidiaries in the United States and/or other countries (“Microchip Trademarks"). Information
regarding Microchip Trademarks can be found at https://www.microchip.com/en-us/about/legal-
information/microchip-trademarks.

ISBN: 979-8-3371-1130-8

Legal Notice

This publication and the information herein may be used only with Microchip products, including

to design, test, and integrate Microchip products with your application. Use of this information

in any other manner violates these terms. Information regarding device applications is provided
only for your convenience and may be superseded by updates. It is your responsibility to ensure
that your application meets with your specifications. Contact your local Microchip sales office for
additional support or, obtain additional support at www.microchip.com/en-us/support/design-help/
client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP “AS IS”. MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY

OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR
PURPOSE, OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR

ITS USE WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO
MICROCHIP FOR THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk,

and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages,
claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise,
under any Microchip intellectual property rights unless otherwise stated.
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Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

* Microchip products meet the specifications contained in their particular Microchip Data Sheet.

+ Microchip believes that its family of products is secure when used in the intended manner, within
operating specifications, and under normal conditions.

+ Microchip values and aggressively protects its intellectual property rights. Attempts to breach the
code protection features of Microchip products are strictly prohibited and may violate the Digital
Millennium Copyright Act.

* Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its
code. Code protection does not mean that we are guaranteeing the product is “unbreakable”.
Code protection is constantly evolving. Microchip is committed to continuously improving the
code protection features of our products.
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